Thermometric Titration of Pyridine

**Purpose:** Determine the concentration and enthalpy of protonation of pyridine.

**Introduction**

Titrations can be done in a solution calorimeter. The temperature of the vessel is monitored as a function of added titrant. Such titrations are called thermometric titrations. Thermometric titrations have become a commonly used method for analytical and reaction enthalpy determinations. Thermometric titrations have become especially important in studies of protein and nucleic acid binding. For example, the enthalpy of binding of an inhibitor to a protein is a common determination. The unique advantages of the thermometric titration method can be illustrated by the titration of pyridine. We will determine the concentration of pyridine in a solution and the enthalpy for protonation of pyridine with HCl:

\[
\text{py} + \text{H}^+ \rightarrow \text{pyH}^+ \quad 1
\]

The analytical sensitivity of thermometric titrations is linearly related to concentration, in contrast to the logarithmic relation to concentration that exists for many other analytical methods, e.g., potentiometric methods. A linear relation is an advantage when very dilute solutions or solutions with high concentrations of interfering ions are being analyzed. For example, pH titrations of pyridine at concentrations below 0.05 M give poorly defined end points, while the end point of a thermometric titration is well defined.

One of the advantages of thermometric titrations for making calorimetric measurements is that an analysis of the reactant mixture is made during the course of the reaction. For example, CO₂ contamination of NaOH solutions becomes obvious during the course of the titration, loss of volatile reactants such as ammonia can be accounted for, and the effects of impurities present in the system can often be eliminated. In addition, a visual representation of all the heats of reaction are presented for each stage as the reactions proceed.

Any calorimetry experiment consists of two parts. The first is the determination of the heat capacity of the system and the second is the determination of the heat effect of the reaction of interest. To find the heat capacity of the system, we add TRIS to the pyridine solution to provide a reaction with a known heat effect. The enthalpy of reaction of TRIS with HCl is accurately known, \( \Delta_r H_{\text{Tris}} \). The heat evolved in the reaction of TRIS is:

\[
Q_{\text{Tris}} = n_{\text{Tris}} \Delta_r H_{\text{Tris}} \quad 2
\]

The heat capacity of the system is then

\[
C_{\text{sys}} = \frac{Q_{\text{Tris}}}{\Delta T_{\text{Tris}}} \quad 3
\]

where \( C_{\text{sys}} \) is the heat capacity of the apparatus and solution, \( n_{\text{Tris}} \) is the number of moles of TRIS, and \( \Delta T_{\text{Tris}} \) is the temperature change during the titration of the TRIS. In effect, the TRIS is acting as an internal standard for the determination of the heat capacity.
But, how can you mix two bases in the same titration? The $k_a$'s of TRIS and pyridine differ by almost five orders of magnitude. TRIS, which is the stronger base, is titrated first, followed by pyridine.

The second part of the calorimetry experiment is the determination of the enthalpy of the reaction of interest. If the change in the temperature for the reaction of pyridine is $\Delta T_{py}$, then the heat produced is:

$$Q_{py} = C_{sys} \Delta T_{py}. \quad 4$$

Since our solution calorimeter is at constant pressure, the molar reaction enthalpy is

$$\Delta_r H_{py} = \frac{Q_{py}}{n_{py}} \quad 5$$

where $n_{py}$ is the number of moles of pyridine in solution.

**Calorimeter**

A computer-controlled buret, an insulated titration vessel, a stirrer, and a recording Wheatstone bridge are needed for this experiment. A schematic diagram of the apparatus is shown in Figure 1. All electrical and mechanical parts enter the vessel through the lid. A motor is used to drive the stirrer.

![Figure 1. Titration calorimeter (Workbench version)](image_url)

A thermistor is used to measure the temperature using a Wheatstone bridge circuit. The circuit diagram for the recording Wheatstone bridge is given in Figure 2. The response of
The thermistor is not linear with temperature, it varies as

\[ R = B \exp \left( \frac{A}{T} \right) \]

where A and B are constants, and R is the resistance of the thermometer. However, over the narrow range of temperatures in this experiment, the variation of the bridge output with temperature is approximately linear. The computer system, through an analog to digital converter, samples the bridge output and displays the results on the screen.

The computer-controlled buret is a tubing pump driven by a stepper motor. The stepper motor is controlled by the computer.

**Theory**

**Analytical Experiment**

A typical titration curve obtained for the thermometric titration of TRIS and pyridine is shown in Figure 3. In the following discussion the symbol of the type A-B means "the line between points A and B".

The data acquisition is started without running the buret to establish the drift rate of the temperature; this gives R-S. If the calorimeter is hotter than the surroundings, the drift will be negative; if it is colder than the surroundings, the drift will be positive. After starting the buret at S, the upward line, S-A, indicates the exothermic reaction of TRIS with acid, with the end point occurring at A. Following this, the reaction of acid with pyridine occurs as indicated by the different slope between A and B, with the end point for this reaction occurring at B. Between B and C, additional titrant is added with no further chemical reaction occurring. The heat effect for B-C is just the enthalpy of dilution of the HCl titrant. At point C, the buret is turned off. Data acquisition is continued for a short time longer to establish the drift rate at the final temperature.

The titrant, HCl, must be standardized so that the concentration is well known. We will use "Acculutes" to make up our titrant. Since the stoichiometry in Eq. 1 is 1:1,

\[ M_x V_x = M_{\text{titrant}} V_{\text{titrant}} \]
where the M's are molar concentrations and the V's are the volume of added unknown and titrant, respectively. For the TRIS titration, \( V_{\text{titrant}} = V_A - V_S \). For the pyridine titration, \( V_{\text{titrant}} = V_B - V_A \).

\[
\begin{align*}
R & \quad S \\
0 & \quad 2.5 \\
0 & \quad \text{buret on} \\
2 & \quad \text{buret off} \\
n & \quad 4 \\
0 & \quad \text{volume (mL)}
\end{align*}
\]

\[
\begin{align*}
H^+ (1 \text{ M}) & \rightarrow H^+ (\text{dilute}) \\
\text{py} + H^+ & \rightarrow \text{pyH}^+ \\
\text{TRIS} + H^+ & \rightarrow \text{TRISH}^+
\end{align*}
\]

Figure 3. A typical thermogram for a titration of a mixture of TRIS and pyridine with HCl.

**Physical Experiment**

The rate of rise of the temperature, as indicated by the slopes of the lines in Figure 3, is proportional to the enthalpy of the reaction involved, if the slopes are corrected for the rate of heat gain or loss caused by the surroundings, the stirrer, the "heater" effect of the thermistor, and the enthalpy of dilution of the titrant.

The system is calibrated for heat capacity using the slope, S-A, for the reaction of strong acid with TRIS, for which the reaction enthalpy is accurately known, 47.49 kJ/mole\(^5\). The correction for heat loss or gain to the surroundings, the stirrer, and the "heater" effect of the thermistor is made for all regions of the titration by using Newton's Law of cooling and slopes R-S and C-D\(^6\). The first step in this correction is to determine the slope of the titration curve subsequent to point A or B if the reaction were to have been stopped at either of those points. These are indicated as A-A' and B-B' in Figure 4. These calculated slopes are then used to find the actual temperature change caused by the reaction by extrapolating both the fore-and after-period slopes to the midpoint of the reaction region to find the temperature change by difference, \( \Delta T_{\text{Tris}} \) and \( \Delta T_{\text{py}} \).
These calculations are done as follows. Let $t_R$ through $t_D$ be the times corresponding to the lettered points in Figure 4, and let $T_R$ through $T_D$ be the corresponding temperatures, measured in millivolts (arbitrary units) from the thermogram. We need to calculate the slopes of each of the line segments; the slopes are indicated by the symbol "M". The slopes R-S and C-D are:

\[ M_{RS} = \frac{T_S - T_R}{t_S - t_R} \]  

\[ M_{CD} = \frac{T_D - T_C}{t_D - t_C} \]  

We estimate the slopes at A-A' and B-B' as weighted sums of the above slopes.

\[ M_A = M_{RS} + (M_{CD} - M_{RS})(T_A - T_S)/(T_C - T_S) \]  

\[ M_B = M_{RS} + (M_{CD} - M_{RS})(T_B - T_S)/(T_C - T_S) \]  

Then extrapolating forward to the midpoint of the TRIS reaction

\[ T_1 = T_S + M_{RS} (t_A - t_S)/2. \]  

Extrapolating backward along A-A' gives

\[ T_2 = T_A - M_A (t_A - t_S)/2. \]  

Finally
\[ \Delta T_{\text{Tris}} = T_2 - T_1. \]  

Similarly
\[ T_3 = T_A + M_A \left( t_B - t_A \right)/2 \]
\[ T_4 = T_B - M_B \left( t_B - t_A \right)/2 \]

and
\[ \Delta T_{\text{py}} = T_4 - T_3. \]

The amount of heat liberated in titrating the TRIS is given by Eq. 2:
\[ Q_{\text{Tris}} = n_{\text{Tris}} \times 47.49 \text{ kJ/mole} \]

which gives the heat capacity of the system at A using Eq. 3 as:
\[ C_{\text{sys,A}} = \frac{Q_{\text{Tris}}}{\Delta T_{\text{Tris}}}. \]

We must determine the heat capacity at B and C indirectly, knowing that the heat capacity of the added titrant between A and C is essentially that of water, 4.184 J/ml/deg. We also need to know the buret delivery rate, R, in mL s\(^{-1}\) and the sensitivity of the Wheatstone bridge in degrees per millivolt, S. The heat capacity at B is the sum of the heat capacity at A plus the heat capacity of the added titrant solution (the change of heat capacity of the solutions due to the reaction is negligible).

This gives
\[ C_{\text{sys,B}} = C_{\text{sys,A}} + (t_B - t_A)R(4.184)(S). \]

Similarly
\[ C_{\text{sys,C}} = C_{\text{sys,B}} + (t_C - t_B)R(4.184)(S). \]

The heat evolved during the titration of pyridine is given using Eq. 4 as
\[ Q_{\text{py}} = C_{\text{sys,B}} \Delta T_{\text{py}} \]

The molar enthalpy of the reaction of HCl with pyridine is then given by Eq. 5, where \( n_{\text{py}} \) is the number of moles of pyridine determined in the analytical part of this experiment.
**Procedure**

Start the "LoggerPro" program. Pull down the "File" Menu and choose "Open." In the file edit box, open the file called "thermometric." This file sets up the titration sequence, Buret control options, and the axes labels and units.

Flush the buret pump by running about 100 steps of the acquisition to flush bubbles out of the system. Determine the delivery rate of the buret by placing water in the titrant flask and weighing the amount of water delivered for 50 steps from the stepper motor, the units will be ml/step. Do three replicates and average the result. To deliver 50 steps: click on the green "Collect" button. Let the acquisition run for 50 sec and click on the red "Stop" button. However, for best reproducibility observe the red LED in the DCU interface box and wait for the LED to turn off before clicking on the Stop button. If you don't get exactly 50 steps, don't worry. Determine the room temperature and then convert from weight to volume using the density of water from the CRC density tables.

Fill the titrant vessel with standardized 1.0 M HCl. Run the buret pump for at least 200 steps to flush out the delivery tube.

Prepare a stock solution of approximately 0.02 M TRIS and one of approximately 0.02 M pyridine. Accurately pipet 25 ml of each of these stock solutions into the reaction vessel. Add 25 mL of deionized water. Start the stirrer. Turn on the Wheatstone bridge. The system will display the output from the bridge. Adjust the bridge to give a value near the bottom of the chart. You can change the maximum and minimum for the chart display, if you need to. Click on the "Collect" button to begin the R-S segment. The temperature drift will be monitored for 30 sec. with the buret pump off. Then the program will start pulsing the pump. Let the buret run about 30 sec after the second end point is complete to yield the B-C segment. Click on "Stop" to begin the C-D segment. Monitor the temperature drift for 30 sec or so. Click on the "Stop" button to finish the run. Remove the titrant delivery tube from the solution. Pull down file and "save" the data to a file, before you go on to analyze the data. Print out the chart by choosing "print" in the File menu.

Extrapolate each section of the thermogram to find the endpoints. To do this, repeat the following for each of the five segments. Drag the mouse over the linear portion of the desired segment. Pull down the "Analyze" menu and choose "linear fit". The system will then calculate the slope and intercept of the segment. Remember to record the slopes and the line numbers; you will need these values for equations 10 and 11. To find the intersections (at S, A, B, and C) expand the x-axis around the intersection and read the intersection with the mouse. The mouse coordinates are listed in the lower-left side of the window.

Do three titrations.

You will also need to know the temperature sensitivity of the Wheatstone bridge. To accomplish this, pour warm water, a degree or so above room temperature, into the calorimeter. Carefully place the stirrer, a 0.001° degree resolution thermometer and the thermistor into the calorimeter. Turn on the bridge and start data collection Record periodic temperature readings on both the thermometer and the bridge output. The sensitivity is defined as

\[ S = \frac{\Delta T (\text{in degrees})}{\Delta T (\text{in millivolts})} \]

Calculate S for a range of temperatures and average the results.
Calculations

Knowing the titrant concentration and the volume added from points S to A and A to B calculate the concentration of TRIS and pyridine in the stock solutions. Make triplicate runs. Report the average concentration for TRIS and pyridine and the standard deviations of the trials.

Use $M_{RS}$ and $M_{CD}$ from the computer curve fitting. Calculate $M_A$ and $M_B$ from equations 10 and 11. Calculate $T_1$ and $T_2$ using equations 12 and 13, and then $\Delta T_{Tris}$ from Eq. 14. Calculate $T_3$ and $T_4$ from equations 15 and 16, and $\Delta T_{py}$ from Eq. 17. The heat capacities at A and B are then found from equations 18, 19, 20, and 23. Finally, calculate the molar enthalpy of reaction, $\Delta_r H_{py}$, using Eq. 22 and 5. Do your calculations for each run separately and average your final $\Delta_r H_{py}$ values. Calculate the standard deviation of the trials. An EXCEL spreadsheet will make your calculations much easier.

Discussion

In your discussion use B-B', extrapolating forwards, and C-D, extrapolating backwards, to estimate the enthalpy of solution of the HCl titrant in the calorimeter. Determine if this enthalpy of solution has any effect on the enthalpy calculated for the reaction of HCl with pyridine. Please include a table containing all of the temperatures and volumes for R through D, $n_{Tris}$, $n_{py}$, the slopes, the heat capacities, $T_1$, $T_2$, $T_3$, $T_4$, $\Delta T_{Tris}$, $\Delta T_{py}$ for each run. Also include S and the concentration of your titrant. What is the predominant error in the measurements? Use significant figure rules to determine the uncertainty in the final result. Does your experimental precision from replicate trials agree, approximately, with the uncertainty you get from significant figure rules?

Literature Cited